If It's Broke, Fix it!
Troubleshooting for Non-Geeks

Presenters:
Bruce L. Dorner
Nerino J. Petro, Jr.

ABA TECHSHOW® 2005
March 31 – April 2, 2005
Chicago, Illinois
www.techshow.com
TABLE OF CONTENTS

I. Bits and Bytes .......................................................................................................................... 1
II. Prevention is the Best Medicine ............................................................................................. 3
III. Troubleshooting: Do You Smell Smoke? ............................................................................. 8
    Solving Hardware Problems .................................................................................................. 9
    Solving Software Problems ............................................................................................... 14
IV. CYA - Do We Really Have to Say This? ........................................................................... 18
V. Where's the Beef - Some of Our Favorite Tips .................................................................... 19
VI. Our Final Words of Advice! .............................................................................................. 20
Additional References ............................................................................................................... 21

If you would like to contact the authors:
Bruce L. Dorner
Dorner Law Office
80 Nashua Road
Londonderry, NH 03053
(603) 434-2230
callmylawyer@attglobal.net

Nerino J. Petro, Jr.
Law Office of Nerino J. Petro, Jr.
349 E. Riverside Blvd.
Loves Park, IL 61111
(815) 636 -1001
nerinop@njpetro.com
nipetro@lawofficetech.com

Copyright Notice:
All materials contained in this paper are copyrighted 2005 by Bruce L. Dorner and Nerino J. Petro, Jr. No claim made to other than original works.

Acknowledgments:
All trademark, service marks and other identify names or symbols are the property of their respective owners and should be treated as such.

Microsoft, Windows, Internet Explorer and Outlook Express are registered trademarks of Microsoft Corporation. Mac and Mac OS X are registered trademarks of Apple Computer, Inc.

ICON TABLE

 وغير 간편하게, Valuable information
 وغير 간편하게, How To
 وغير 간편하게, Left Mouse Button Click or Double Click
I. Bits and Bytes.

To err is human--and to blame it on a computer is even more so. Robert Orben

Between us, your authors have numerous years of dealing with (and cursing at) personal computers. One thing that we believe everyone can agree on is this: the relationship between a person and their computer is truly a love-hate relationship. If you haven’t encountered problems yet, the good news is that there are some common sense steps that you can take to prevent problems from happening or which will make recovering from a problem much easier. Now, so as to avoid confusion, our focus is strictly on Windows/Intel (a/k/a WINTEL) issues. You should also understand that some of the same approaches will work in the Macintosh and Open Source world as well. This isn’t because only the WINTEL platform has issues, but the real life fact that the true majority of personal computers used in the legal industry are WINTEL systems.

Bruce believes that there are four key conclusions that I concur with and that we want to share. First, with patience and persistence, almost all of the problems you will run into can be solved. Second, as much as we hate to admit it, the human element or “operator errors” are often the cause of problems, even though we really want to blame the computer or Bill Gates. Third, it really is true that sometimes all you can do is reboot. Finally, printer errors remain the greatest unsolved mysteries faced by humans.

Now, here are a few points we want to make as we begin:

1. There are no guaranties. At some point in time, despite everything you do, you will have a problem. Murphy’s Law is a constant and it will strike at the worst time.

2. If you connect to the Internet or use e-mail, you will encounter a virus at some point in time. If your computer starts to act like it’s possessed, you should immediately think “virus.” Chances are very good that your computer has been invaded. You may have gotten a virus, worm, Trojan or spyware on your computer. It’s ugly out there. The bad guys have gotten more sophisticated: the latest round of viruses, Trojans and worms carry even more malicious and capable payloads. Running and constantly updating antivirus and anti-spyware software is vital. You will also want to be aware of the “symptoms” of widespread viruses. Assuming that your problem has left you with reasonable functionality, update your antivirus and anti-spyware software and scan your system. You may solve your current problem, but you will need to check to see the damage that might have done.

3. Don’t lie about what you did. If you want to diagnose and fix a problem, telling the truth to yourself and others is an important first step. If you had to force a card into a slot on your motherboard shortly before you observed the problem, you hamper the ability of someone attempting to solve the problem if you don’t mention it. If you opened 25 different instances of the same program and we can see that on the screen, it doesn’t help to have you say, “It just happened.” Finally, even if it embarrasses you, give up the relevant evidence. If we know that you have been surfing porn sites, installing bootleg software or downloading files from hacker sites, we are far more likely to find and fix the problem than if you lie about it.

4. In the Windows world, Windows XP is now the way to go and you should use Windows XP Professional not XP Home. With Windows XP, the Windows operating system has reached a welcome degree of stability. For security, compatibility and other reasons, working in a fully
updated Windows XP Professional environment is generally our recommended approach in today’s business selling, especially when you plan to use new hardware components and peripherals. Plug and Play (“PnP”) is no longer referred to as “Plug and Pray” In addition, running current, patched versions of software programs will also contribute to a more stable and generally trouble-free experience (However, remember point #1 above). If you haven’t installed XP SP2 (Service Pack 2), you should probably consider installing it at this time. However, you need to be aware that your anti-virus and other programs may not work or will need to be patched or modified.

You may want to look at these web pages before installing XP SP2:
http://www.microsoft.com/windowsxp/sp2/default.mspx
http://support.microsoft.com/default.aspx?&pr=windowsxpsp2

Ideally, you are taking steps or will take steps to try and prevent problems in advance. With this in mind, we’ve provided the next section on preventative steps that you can take. This is followed by how to troubleshoot hardware and software problems.
II. Prevention is the Best Medicine.

Treat your password like your toothbrush. Don't let anybody else use it, and get a new one every six months. Clifford Stoll

The best way to prepare for problems is to take steps to prevent them from happening. Computers are pieces of electronic equipment that are stressed by the very act of turning them on and off; contain parts that are constantly in operation such as cooling fans, power supplies and hard drives; they are affected by temperature and by dirt and other airborne pollutants which can impact on efficient operation. These are just the local dangers which don’t take into effect the dangers from viruses, worms, spy ware, hijack programs and hackers just waiting to run amok on your computer and/or your network. These dangers, much like the barbarians of old, if they get within the gates of the city, they will do everything to tear down, loot and pillage. But you can take steps to make sure that you can withstand these assaults and keep your computer safe from mechanical and non-mechanical problems.

1. Turn on Automatic Updates. In Windows, you have several options for Automatic Updates as follows:
   1.1. Automatically download and install any updates;
   1.2. Automatically download updates, but doesn’t install them until you decide;
   1.3. Notify you of updates only;
   1.4. Turn it off

   We recommend that you select either 1.1 or 1.2; with option 1.1 being the safest for non-technical users.

   To Activate Automatic Updates:
   In Windows XP, if you are using the Category View do the following:
   Go to Start
   ☁ Control Panel
   ☁ Performance and Maintenance
   ☁ See basic information about your computer
   ☁ Automatic Updates Tab

   If you are using Classic View:
   Go to Start
   ☁ Control Panel
   ☁ System > Automatic Updates.

2. Adjust System and Other Settings in Internet Explorer (“IE”): In IE, you need to have your Security Settings for the Internet set to at least a Medium Level. This will prevent anyone from installing ActiveX or Java Scripts without requiring your approval. You also need to set your Privacy level to at least Medium as well to prevent unauthorized cookies (messages from a web server to your browser that can be used for good as well as bad purposes) from
being placed on your system.

▶ To Adjust System Settings:
Open IE.
▶ Tools
▶ Internet Options
▶ Security
▶ Internet
▶ Custom Level.

▶ To Adjust Privacy Settings:
Open IE.
▶ Tools
▶ Internet Options
▶ Privacy.

3. Adjust Settings in Outlook Express (“OE”): If you are using OE as your email client, you should disable the preview pane. You should also disable OE’s ability to automatically complete the address field and to disable the ability to send messages immediately. Disabling the auto address complete prevents you from inadvertently sending a message to the wrong party. Disabling the Send Immediately function, allows you an opportunity to verify the correct address and to prevent you from sending before you are positive it is ready to send. This removes the possibility of committing malpractice by sending a message to an improper party.

▶ To disable the Preview pane:
Open OE
▶ View
▶ Layout Uncheck “Show Preview Pane”

▶ To disable auto address complete:
Open OE.
▶ Tools
▶ Options
▶ Send.
Uncheck Send Messages Immediately.
Uncheck Automatically complete e-mail addresses when composing.

▶ To avoid many of these problems, you can also switch to alternative products such as the free Mozilla Firebird web browser and the Thunderbird e-mail client available from: http://www.mozilla.org/.

4. Update your Anti-Virus Signature Definition Files. Your anti-virus program will only be as good as its signature files. If your program has the ability to check and download these files automatically, make sure it’s on and set it to download these files at a minimum once a week, but better is to check for updates everyday. If your program cannot download automatically,
then you need to do this yourself at least every week.

啻► For non-commercial use, you can obtain the free AVG anti-virus from Grisoft at http://www.grisoft.com. They also have commercial versions available. You can also have your system scanned for free using the Trend Micro Housecall site at: http://housecall.trendmicro.com. Or the McAfee Freescan at http://us.mcafee.com/root/mfs/default.asp?cid=13121.

5. **Backup your Critical Files and Preferably your Entire System.** Backup methodologies vary and different people have different ideas of what to backup and what not to backup. Some believe that you only need to backup your data, not your program files: the logic behind this is that you have your program disks so you can re-install your programs from them. We disagree. This approach overlooks all of the updates, patches and Service Packs that you have installed. It also doesn’t take into consideration your need to find all of your disks, including your operating system disks. Regardless of what you decide, you need to backup on a regular basis. A current backup can make recovering from a system crash or a virus or spy ware much easier and quicker. A backup from 2 months ago won’t do you any good for a current problem. Your authors have a difference of opinion when it comes to backups and moving to a new computer.

Bruce believes that you should only use your backup to move your data over doing a clean install of your operating system and programs from the original installation disks. Bruce feels that this prevents moving programs from older operating systems that may not work with Windows XP. This also prevents you from installing older programs that have been updated. Nerino agrees that if your are updating to a new operating system this makes sense; however, if you make a base line image immediately after you’ve installed your OS and programs, you should install from this backup to save time and aggravation that goes along with doing a clean install of the OS and each program individually. Either method will work; it’s a matter of personal preference.

啻► There are several programs that allow you to make an image of your entire disk including:
Norton Ghost  http://www.symantec.com/sabu/ghost/ghost_personal/
Acronis True Image  http://www.acronis.com/
You can also use a backup program such as Backup MyPC from StompSoft which includes the ability to create disaster recovery disks. www.stompsoft.com.
There’s also the Backup utility that is included with Windows. For XP Pro, the Backup utility is installed with the operating system. Unfortunately, Microsoft does not have it automatically installed for XP Home but DOES include it on the installation CD-ROM and instructions for installing it are below.

啻► Access Windows Backup in Windows XP Pro:
- Start
- All Programs
- Accessories
- System Tools
Backup.

Access Windows Backup in Windows XP Home:
- Insert the XP Home CD-ROM
- `X:\Valueadd\msft\ntbackup` where X: is the letter of your CD drive.
- Double click NTBACKUP.MSI (it may also appear as "Ntbackup".
- Complete the Windows Backup Utility Installation Wizard
- Click "Finish.
Follow steps above under XP Pro to run.

Another alternative is to create a Boot Disk with Windows XP and all the most recent Hot Fixes and Service packs on it. This can also be very helpful when you can’t get your Win XP computer to boot up. The process of adding the hot fixes and Service Packs to the basic Windows installation is called “Slipstreaming.” This allows you to install the Service Pack at the same time you are installing the OS. You can find step by step instructions on how to do this at: [http://www.helpwithwindows.com/WindowsXP/winxp-sp2-bootcd.html](http://www.helpwithwindows.com/WindowsXP/winxp-sp2-bootcd.html)

For those of you more comfortable with technology, Nerino suggests you create a BartPE (Bart’s PreInstalled Environment) CD-ROM. A BartPE disk provides you with a full network support and can include disk and anti-virus utilities. Step by step instructions can be found at: [http://www.nu2.nu/pebuilder/](http://www.nu2.nu/pebuilder/).

WARNING: Always make a complete backup and create a restore point before making any changes to your computer.

6. **Install an Anti-Spyware and Adware program.** If you are connected to the internet, you need to install and keep updated a program to protect you from spyware and adware. The best of these programs take snapshots of your registry and run all the time. When a program tries to install itself or to make changes to your system, it will block it and alert you to this problem. There are freeware versions available such as Ad Aware SE and Spybot Search & Destroy. Commercial products include Ad Aware, Spy Sweeper and Spy Subtract. Just as with the Anti-virus programs, these programs rely on definition files to identify threats which need to be updated on a regular basis. There is nothing wrong with having 2 of these products on your system and running both of them as one may detect something the other misses. For example, you can run both Spybot and SpySweeper or Spybot and Ad Aware. The commercial products can also be set to run automatically on a given schedule which we recommend.


The free version of Ad Aware SE from Lavasoft can be found at: [http://www.lavasoft.com](http://www.lavasoft.com). Nerino has used Spybot Search & Destroy, Ad-Aware and SpySweeper (http://www.webroot.com/) with success.

7. **Install a Firewall.** Make sure that you and your network are protected by a firewall. Firewalls are designed to prevent unauthorized access to a computer or network. Sometimes referred to as gateway or perimeter devices, firewalls sit between the Internet and your
computer or network. They are the first line of defense against HACKERS and other attempts to gain unauthorized access. There are 2 types of Firewalls that can be used a) software and b) hardware. Firewalls also block Ports used by programs to communicate, thereby preventing unauthorized use of them by anyone. You can use both types of firewalls for maximum protection.

2 very popular and effective software firewalls are ZoneAlarm Pro from ZoneLabs at http://www.zonelabs.com and Norton Personal Firewall at http://www.symantec.com. Both of these are commercial products, but well worth the investment as the few remaining free firewalls are limited versions of the commercial products.

8. Run System Utilities. Windows includes system utilities that can help keep your system running smoother. These include Disk Cleanup and Disk Defragmenter tools. Running these on a regular basis can keep your operating system and your hard drives running in top form.
III. Troubleshooting: Do You Smell Smoke?

If the automobile had followed the same development cycle as the computer, a Rolls-Royce would today cost $100, get a million miles per gallon, and explode once a year, killing everyone inside. Robert X. Cringely

We’ve all been there, working on that all important brief or contract due tomorrow or perhaps it’s Friday at 4 PM and you’ve planned a night out with your significant other. Suddenly, there’s a problem; take your pick from a) system freezes, b) system crashes, c) your screen is covered with pornographic website ads d) your documents refuse to print e) it starts acting as if possessed or f) one of a myriad other problems that we have all experienced over the years. At this point you usually experience quickened pulse, shortness of breath, the room starts to spin and you start repeatedly clicking the mouse or hitting the enter button. You also realize that you haven’t (select one or more) 1) saved your work, 2) updated your anti-virus signature files or 3) installed Windows critical updates and patches. WHAT ARE YOU GOING TO DO? First, put down the mouse and step away from the keyboard. Second, stop, DO NOT PANIC. Now, take a deep breath, go ahead, take another one (it’s free). Panic and continued mouse clicks will not help your situation and may even make it worse.

Take a walk, get something to drink and clear your mind. Then, armed with the knowledge you will have learned from this session, you will attain oneness with your computer and begin the task of mastering this machine.

Many problems can be solved using common sense and a calm head. It’s critical that you have a plan or at least a logical order or method in approaching your problem., there are certain basic, common sense steps to follow in undertaking basic troubleshooting so that’s where we’ll start. While there may be some differences in steps or the order to undertake them, we have found that the basic steps are covered by the acronym SIGNAL detailed as follows:

1. **Stop:** stay calm - focus on resolving the problem. Panic = bad; Calm = good.
2. **Identify** the problem (or what seems to have happened) i.e. system frozen, document won’t print; can’t connect to the Internet.
3. **Gather** information regarding the problem. What happened, when, is there an error message on the screen, has anything changed recently i.e. new programs or updates for programs installed, was a piece of hardware installed or replaced; has the system been moved or opened recently?
4. **Note** what you’ve gathered including any error messages, warnings and other information on paper.
5. **Act** on the information that you’ve assembled in a logical and methodical fashion. Try one thing and finish it, before trying something else.
6. **Log it.** Write down everything you’ve found and the steps that you’ve taken to correct or try to correct the problem. This data can be truly valuable when you’re trying to figure out if you made the problem better, worse, or created any new problems.
Solving Hardware Problems.

Imagine if every Thursday your shoes exploded if you tied them the usual way. This happens to us all the time with computers, and nobody thinks of complaining. Jef Raskin

1. Start at the beginning. Is everything plugged in and connected? When you don’t hear the fan and you don’t see any blinking lights, check to make sure the computer power cord is plugged in. It’s quite amazing how an errant vacuum cleaner can jar a plug just enough that it prevents a good connection. Along the way, be sure to check both ends. Sometimes it’s at the wall, sometimes at the computer. While you’re there, check all the other connections including the USB ports, the serial and parallel connections and the video cord. Connections for modems, scanners and printers can also mysteriously disconnect. Remember to check both the power cords and the USB or other connections to your computer. In the new wireless world, you also need to check that wireless routers and cards are on or are fully connected. We’d rather be seen as being too simplistic than to have a support call where we have to sheepishly say “Never mind, it was unplugged.”

2. Listen to the sound or noises your computer is or isn’t making. If you hear an unusual series of beeps when you start the computer, pay close attention. Depending upon the type of motherboard in your machine, the beeps indicate a potential source of the problem. You do have the specification sheet for your motherboard, don’t you? If not see the Helpful Hint below. Has your system been moved or bumped lately? It could be that one of the cards or connections inside the computer has come loose. You will have to open the computer case. Before opening the case, see our notes in item 5 below. Again, often you will find a simple connection problem. Check each of the cords, chips and plugs and be sure everything is seated firmly. Suspect this type of problem if you have recently moved, bumped or dropped your computer.

► If you don’t know your motherboard model or other information for your computer, download and run Belarc Adviser from http://www.belarc.com/free_download.html. This program will provide you with detailed information about your computer including your motherboard model. You can also get the Everest free Home edition at: http://www.lavalys.com/products/overview.php?pid=1&lang=en&pageid=1 which will provide hardware information on your computer. Everest is the successor to the AIDA32 Personal Information Tool which Nerino still uses which is available at http://www.sofotex.com/AIDA32-download_L9326.html although no future updates will be available since its author now works for Lavalys Consulting Group, Inc the makers of Everest.

3. Try to determine, as best as you can, whether you have a hardware problem or a software problem. If you get any kind of error message, make a note of exactly what the error message says. In the vast majority of cases, you will have a software problem, probably related to Windows. It is a good idea, however, to rule out hardware problems. While you can develop a feel for these things, for most of us, some kind of failure is a good clue that you have a hardware problem. For example, if you look in “My Computer” or Windows Explorer and no longer see a hard drive or CD drive, you will want to focus on hardware issues. If you are able to access the Internet, run a search on Google on the error message and see if you can find a diagnosis, explanation or solution to the problem.
4. If your system is still running, you may be able to use Windows own internal diagnostics tools.

4.1. The Device Manager located in the System folder in Control Panel (Classic View) allows you to check for hardware problems or conflicts. Here, you will find a list of all your installed hardware components. If Windows detects a problem it will place a yellow exclamation point (!) or a Red X to the left of the component. Double-click on any component that you suspect has a problem. You will see a box called “Device Status” that, among other things, will tell you if the component is working properly. Even if you see that message, click on the “Troubleshoot” button you see there and you will be taken to a series of multiple choice screens that will help you diagnose and, in some, but not all, cases lead you to the resolution of the problem.

4.2. Windows Event Viewer located in the Administrative Services folder in Control Panel can be used to review a log of events, which you can use to identify problems with installed components. Event Viewer is an often overlooked utility that can be extremely helpful in diagnosing problems. Click on one of the areas in the left window such as System to display an event log in the right window. Warning messages will have an Exclamation Sign on a Yellow triangular background. Errors will have a white X on a red circular background. Double clicking on these will bring up the entry which can also be used to link to the Microsoft Help and Support database on the Internet.

To Access System Properties:

Start
Control Panel (classic view)
System
Hardware tab
Device Manager Button

To Access Windows Event Viewer:

Start
Control Panel (classic view)
Administrative Services
Event Viewer

5. Reboot the machine. This old standby can resolve a lot of “mysterious” problems that can be caused by random program errors and such.

5.1. There are “soft” reboots and “hard” reboots. A “hard” reboot means that you turn the power off and on. Always try the “soft” reboot first. The easiest way to do this in today’s versions of Windows is to go to begin from the “Start” button. In older versions of Windows, using the Microsoft “3 key salute” method by hitting the CTRL, ALT and DELETE keys at the same time will accomplish the same thing. In Windows XP, hitting these keys will pop up the Task Manager and you can choose “Restart” from the “Shutdown” menu. It’s amazing how many problems can be cured by simply rebooting the computer

Soft Reboot:
Start
Turn Off Computer
Restart.

Soft Reboot using 3 Key Method:
CTRL + ALT + DELETE Keys(simultaneously)
Shut Down
Restart

5.2. Use the Off/On Switch. This technique is known as “hard” rebooting. Generally, you resort to this technique if you can’t do a “soft” reboot. This is a situation where everything is frozen on the screen even after waiting for a few minutes. Actually, if you can’t do a soft reboot, all you can do is turn the computer off and on. Don’t be bashful – if you reach this point, you are well beyond being able to save any of your unsaved work or making anything worse. There are also times when you can do a soft reboot but the problem still exists. In a few circumstances, for reasons no one can adequately explain, turning the computer off and on will solve the problem. Don’t get your hopes up, though. The Off/On switch technique is most likely to work when applied to external components, such as modems, printers, scanners and routers. Don’t ask us – it just works. Sometimes.

If you do a “hard” reboot, you may have to hold the Off/On switch for up to 10 seconds before the computer will shut off. You should also let the machine stay off for a minute or more: you need to let the capacitors on the motherboard fully discharge.

6. There’s a right way to check the innards of your computer. If you have to open up and work on your computer, you will want to be careful not to accidentally cause more damage. First, turn your computer off and be sure to unplug it from the wall. Second (and ideally,) you should use a wrist grounding strap to prevent a static electricity discharge (yes, static electricity can fry computer components). These can be found at your local computer store. At a minimum, make sure you touch some other piece of metal before you touch anything on the inside of the case. You might look or feel a little silly, but it’s better than zapping your processor chip. There is some good news. Computer magazines like PC Magazine, MaximumPC, CPU and PC World (and their websites) occasionally have step-by-step articles (with pictures) that will walk you through how to install or replace parts. There are also numerous websites that also provide helpful information.


7. Most of us keep our computers on the floor. Take a good hard look at the conditions around your computer. Chances are if it’s dirty around the computer, the inside of your computer will be no better. If you’ve opened the case, be sure to perform a dustectomy. Dust bunnies are not your friends and can result in numerous problems including damaging cooling fans inside the power supply and inside the case. Modern CPU’s run extremely hot and there’s nothing that will mess up your machine more than heat. Dust in the case, in the power supply, around the expansion cards and covering the processor can be sources of temperature
increase. Most of the time the dust will lodge around the fan. Don’t use a vacuum cleaner – if you can avoid it as the plastic nozzle can discharge static electricity and can also be too powerful. Use a can of compressed air to blow the stuff out, but make sure you don’t put the nozzle closer than 3 or 4 inches to any component as this can cause damage. Keep the vacuum nearby to clean up the dust bunnies that emerge. After you blow out the inside of the case, remember to blow out the power supply as well.

8. Shaking, banging and other undocumented methods. As is the case with other repair work, your options multiply greatly when no one is around to see you or hear you. While uncommon, we have heard reports that computers respond to strings of screamed obscenities or a good slap, much as the way many of our parents dealt with television sets in our childhood. Nerino recalls the tale of one computer that would start making sounds, like a piece of metal vibrating. If you thumped the top of the case it would quiet down. Turns out it was a cooling fan on the motherboard chipset going bad. The thump would get the fan spinning again. Among the techniques that may work for you are pounding your fist once or twice on aging monitors, opening and closing all doors and pulling out and putting back in the cartridge in laser printers, and, of course, slapping the side of your computer to silence humming hard drives, CD drives or fans. Or so we have heard. Neither of us would ever suggest these types of “field expedient” repair methods, but in the interest of being “fair and balanced” we believe we need to let you know that some people do believe in these methods. Bruce refers to the bang and slap approach as an ‘MPM.’ That stands for Mild Percussive Movement! Nerino prefers to call it a FET – Field Expedient Thump.

9. Finding a friendly repair shop. We’ve all seen the commercials where the husband tells the wife he can fix the problem, only to end up making it worse. Our main goal in troubleshooting a computer is to make a proper diagnosis. If we can do that, we can make a good decision about what to do next. There are many problems that you cannot fix on your own. Unfortunately, you don’t find many computer repair shops these days and the labor costs of tracking down and fixing your problem might well be prohibitive, especially if your system is more than 2 years old. We’d like to be more positive than we are on the issue, but we want to be accurate. If you have found a reliable computer repair shop, you are lucky.

► There are a few chains that are now nationwide offering computer service. The most widely publicized recently is Geek Squad http://www.geeksquad.com/main.asp. What is unique about this company is that they’ve partnered with the Best Buy electronics chain and are located in those stores.

10. Buy or build. There are some problems that either no one can fix or the cost of repairing them is way out of proportion to the benefit you gain by getting it fixed. This is especially true for aging components. If you know your options, you can make a wise choice. The economics of computer technology often surprise people because the “best” choice is to simply buy something new. Here are some examples: If your system is more than 2 years old and it’s going to cost over $400.00 to repair it, you should seriously consider buying a new computer. For a few hundred dollars more you can get a faster system, with all new components. The same holds true for related equipment like printers. Any kind of repair work, plus parts, for an old personal laser printer could easily run several hundred dollars. For under $200, you can get a new laser printer that triples your pages per minute. As much as you might like to “fix” hardware, the economics often argue for replacement.
11. Accept the fact that one vendor will point a finger at another. We’ve noticed that no matter what contractor comes out to our houses, they will always comment that the guy who did the roof/electrical/carpet before didn’t know what he was doing. It’s uncanny. In the world of computers, this tendency is multiplied. Hardware will blame software and software will blame hardware. Most of the time both sides believe they are telling you the truth. If you have a situation where a network or Internet access is involved, you will have so many fingers pointed in so many directions that you will throw up your hands.

12. Get your facts in order. Customer support at hardware vendors will often surprise you with helpfulness and the resolution of your problem. This goes back to our troubleshooting tip of SIGNAL and logging everything in writing. Customer support people work from scripts, use decision trees and recognize common problems. However, they can’t do a good job if you don’t have the necessary serial numbers, list of components and other information. Some manufacturers keep that information in a file or your computer (usually in a file with some indecipherable name). Mentioned earlier, Belarc Advisor pulls together a comprehensive report with details about your computer setup and having a printout of this report can be invaluable during a support call. Important: If the problem occurred after you added a new hardware component or software program, remember to tell the support person.

13. Isolate the problem. You can make the diagnosis of a hardware problem far more difficult than it should be. For example, if you have a modem that is not connecting to the Internet, even though it seems to be dialing out, you can isolate the problem in a few steps. Your problem is either going to be with the modem or the phone line. If you have two phone lines, connect the modem to the second line. If the same problem persists, the problem is in the modem (unless a squirrel chewed through both your phone lines). If the modem works on the second line, you have a phone line problem (and you can confirm that by trying a different modem on your computer). Similarly, if you have installed a new piece of hardware, remove it and see if the problem disappears. With a few simple steps, you can identify a problem and get help in fixing it. Compare this approach to the common approach of simply saying, “My Internet doesn’t work.”

14. Even with the current state of Windows Plug and Play hardware, drivers still burp from time to time. When something with a USB connection takes an unscheduled vacation, start by turning off the machine. Unplug the device and then restart the machine. After it boots completely, plug in the device again. If it still burps, then go into Device Manager and delete the drivers for that particular device. Turn off the computer, unplug the USB gadget and then restart the machine. When you restart, Windows should find the new device and automatically reinstall the driver for it (note: you may need the original installation disk). Occasionally drivers get corrupted or driver software is updated to take care of issues (like the one you are suffering from). Checking the website of a hardware vendor for a new version of the driver software might resolve your problem or, although this is no fun, let you know that the hardware component will not work on your system. Remember there are sprites and gremlins living within that metal box and from time to time they just have to come out to play with your sanity.

15. FYI, the army isn’t the only area that uses a lot of acronyms. For those who love acronyms, computers and software have tons of them. One of these that we will share with you is IRQ’s. IRQ stands for “interrupt request lines” which are the points where the hardware components are registered on your machine. There are only a limited number of these points, and when
you put too many devices on a fixed IRQ, there are often conflicts. When this happens, one or more hardware devices will cease to work correctly. As we mentioned, when you open Device Manager, you can find a list of all your components. If you see a red or yellow indicator, that means there is a conflict. Moving devices to another IRQ isn’t too hard, but it’s something that should be done cautiously. Start by using the Troubleshooter item on the menu. Keep detailed notes of your changes and be sure to reboot and check Device Manager again to be sure that peace has been restored. If you want to see what other components are sharing the same IRQ, you can see this information under the Resource by Connection view in Device Manager.

To Access System Properties:
- Start
- Control Panel (classic view)
- System
- Hardware tab
- Device Manager Button
- View
- Resources by Connection

Solving Software Problems.

"A computer lets you make more mistakes faster than any invention in human history - with the possible exceptions of handguns and tequila." -- Mitch Ratcliffe

1. Troubleshooting software problems can be difficult and frustrating. At some point you will be told to take a drastic step to solve your problem, which you want to avoid as long as possible. We’re talking about the dreaded statement form tech support where they say “you really should reformat the hard disk and reinstall the operating system.” That’s easy for them to say. Ask them how often they do that. This approach is the equivalent of having the auto repair shop supervisor tell you that “you really should just swap out the motor and put a new one in.” Sure, that will work, but you probably want to try a few interim approaches. Many computers today don’t even include a separate CD-ROM with just the Windows OS on it; they include a “Disaster Recovery Disk” that contains an image of your hard drive on the date it was shipped by the company. Restoring from this will reinstall everything and overwrite all of your data. You want to avoid this drastic solution as long as you can. Part of your response will be based on the level of backup you have, how much time you have and a number of other factors. Of course, if you have a mirror image of the system just before the problem arose, you know, those of you who use a disk imaging program like Norton Ghost or Acronis True Image on a regular basis, you might well take this option. OK, all those with that level of compulsive behavior raise your hands! The rest of us will need to scurry to find original program disks, serial numbers and the like. Some have argued recently that the sheer volume of Windows Updates you would need to reinstall make a full reinstall extremely unpractical for those with dial-up access.

We want to reiterate again that reformattting and reinstalling everything is a drastic measure that should only be done as a last resort. Additionally, even if you are going to do this, ideally you should make a backup of your existing system in total or at least your
2. Sometimes, prevention is the best tool. As we mentioned, a fully updated version of Windows (ideally Windows XP Pro) is essential these days. And be sure to keep your system current. Using the auto-update feature is a wise choice, but, if you aren’t comfortable with that, you need to check the Windows Update site regularly. Install all Critical Updates and the necessary drivers. It is prudent to set a Restore Point before you install updates, especially any drivers. No matter how hard Microsoft tries to “get it right,” many security holes keep showing up in Windows and Internet Explorer. Without the patches, your computer is a ticking time bomb because current viruses exploit these security holes and use your computer to launch more attacks.

3. Restore Point is a wonderful feature in Windows XP. While this doesn’t make a complete backup of your computer, it does allow you to “turn back the clock” so to speak if you experience problems after installing a new piece of software or think you have been hit with spy ware. If you’re not familiar, use the Windows Help feature to get the details. It can restore the computer to a prior state of affairs. It’s a good idea to set a Restore Point before you install any new software or an update to an existing program. If you can develop this habit, you’ll be way ahead of most computer users.

4. The error message, if any, is the key. Often the solution is in the message. Does the same error and error message reproduce itself when you’re running a particular program? Does it happen every time when you start your machine? Can you perform a series of tasks that will reproduce the error? If so, you have found what is known as a “reproducible error,” and you’re halfway to the fix! If the error is within a Microsoft application, then you should immediately go to the Microsoft Knowledge Base on the Microsoft website and research the problem. It’s really refreshing that many of the solutions are easy to find and implement. You can also use Google to search for the error message and find articles and/or potential solutions.

5. Non-reproducible errors are the most difficult problems. Some problems simply happen sporadically. They are almost impossible to diagnose and fix. With a reproducible error, you can invoke the “Henny Youngman doctor joke” technique: “Doc, my arm hurts when I do this.” “Well, don’t do that.” In “technical” terms, this approach is known as creating a work-around, but the principle is the same. We use this approach all the time. If we can’t print to a certain printer from a certain program on one computer, but we can from another computer, we learn to use that program from the other computer if we know we need to print. That is an “acceptable work-around.” In other cases, the work-around is unacceptable. Non-reproducible errors are not subject to easy fix and can linger on for months. If they are disruptive enough, you will have to move to the drastic approaches. To a technician, simply reinstalling Windows is faster and cheaper than bothering to track down the cause or explanation for a problem.
6. Shut down the offending process. Unfortunately, most of the time we do not get a helpful error message. Instead, our computer or a program just hangs. You might suspect that the problem is in one program when in fact it is in another. Here’s where even a rudimentary familiarity with Task Manager will help you greatly because if will move you out of the “my computer isn’t working” category and into the “helpful problem solver” category. If you experience a “lock up” or a “hang,” you do the Microsoft “three finger salute” (hit the CTRL, ALT and DELETE keys simultaneously) and Task Manager will pop up. On the Processes tab, Task Manager shows you all the programs and processes that are running on your computer. The sheer number may shock you (and may indicate the presence of spyware and other problems—a topic for another day. Usually, you will see that one program or process will be using about 98% of the CPU memory. That’s the offender. Click on that process and click on the End Process button. A confusing and scary warning will appear and you will click that you want to proceed anyway (it’s not as if you have a practical choice). This will shut down the offending program and you can relaunch the program in the normal manner. Depending on the program, you may or may not have lost your work. However, you are back in action.

The ability to end a process (think program) without having to reboot your computer is one of the real improvements in Windows XP and in our minds sufficient reason to upgrade to it. This also helps avoid the dreaded GPF (“General Protection Fault”) a/k/a the “Blue Screen of Death.” Windows XP no longer allows programs to have direct access to the computer’s hardware but makes all programs go through it for hardware control. While you will still occasionally have to reboot your computer, the need for doing this has been, if not totally eliminated, greatly reduced in Windows XP.

7. Are the problems occurring when a certain set of programs is running at the same time? If so, close down the other programs one by one. One of our esteemed colleagues has noticed lately that, when running multiple programs, some programs will pop up message screens that do not show in your task bar. If you switch around among programs, you might find that a program appears to have locked up, but only because it is in the “message” mode and won’t do anything until you click on the message box. Since you can’t see the box, you don’t know that and the program appears to be locked up and you may find some unpredictable behaviors. Also, depending on the amount of internal memory (RAM) that you have, running a lot of programs or having 40 browser windows open can cause instability and other problems. If you do not see a clue in Task Manager, closing program windows and exiting programs can get you out of the problem without a need to reboot.

8. Use Legitimate, Licensed Versions of Programs. There are many reasons—legal, moral and otherwise—to use only programs properly licensed to you, but if you do not do so or you use a trial version past its deadlines, you can run into a variety of problems, ranging from reduced functionality to inability to get needed updates. Using pirated software, limited versions and other “too good to be true” software bargains is an invitation to disaster. Replacing this software with legitimate versions will likely resolve your issues. You will also avoid running afoul of the BSA (Business Software Alliance not Boy Scouts of America) and one of their lawsuits. All it takes is one disgruntled employee (or ex-employee) to make a call and suddenly the guys in the blue jackets are swarming over your office.
The first thing to do if your systems start acting up is to scan for viruses, spyware and assorted malware. “Hey, let’s be careful out there.” The Internet is no longer a friendly environment: there are all kinds of bad people out there just waiting for a chance to demonstrate their skills by causing your computer harm. If you think of these threats as Cyber-barbarians trying to breach your gates, you’ll have the right mindset to protect yourself and your extremely important data.

These issues not only threaten loss of time and damage to your systems, but can also result in loss of irreplaceable data and unauthorized disclosure and/or distribution of confidential and privileged information leading to potential malpractice claims against you and your firm. Protecting your computer from these threats is an instance where you truly are better to be proactive, to “go on the offensive” to take steps to safeguard yourself, your firm and your clients. So man the walls, raise the drawbridge and prepare for battle because the Cyber-Barbarians are at the Gate intent on ravaging what you hold dear!

9. Use the Internet. Software companies commonly discuss known issues and incompatibilities on their websites. Computer magazines and websites report issues and may point you to fixes and critical updates.

10. Update Windows and considering upgrading software versions. Microsoft doesn’t update Windows to fix security flaws. An update may include a fix that addresses your specific problem. The more versions you are behind the current version of a program (e.g., you are using WordPerfect 8 and the current version is WordPerfect 12), the more likely you are to suffer from problems that have been addressed in later versions.

11. Retrace your steps. Did you install a new program or hardware component shortly before you saw the problem? Did you change configuration options; change security options or engaged in some form of risky computing (such as opening an email attachment)? All the clues you can find will help you or tech support find and fix your problem.

12. Rebooting is always an option. Try a “soft” reboot first and then turn the computer off and

13. Windows likes “clean” shutdowns. The worst feeling you can get is when you get an error message or a “hang” when starting Windows. At this point you don’t get any further than the “Starting Windows” screen. At this point you can try a 3 finger salute or use your Off/On switch. If you are lucky, Windows will cycle through and essentially fix itself. However, if it doesn’t start normally, you will need to restart the computer and when it restarts, you want to enter “Safe Mode”. If you have the option to load the last known good configuration you can try this option. Otherwise, you will need to try and open in Safe Mode. Safe Mode is Windows with a bare minimum of drivers and other software installing. This mode is best if you the problem started right after installing a new program or piece of hardware. In Safe Mode you can disable or uninstall the hardware, device driver or software that is causing the problem.
IV. CYA - Do We Really Have to Say This?

Why is it drug addicts and computer aficionados are both called users? Clifford Stoll

The Grand Daddy of all computer rules comes in three parts. Backup, backup, and backup. Do you get the importance of the three parts? You can never be too rich, too thin, or have too many backups of your data. Bruce’s rule for backup is very simple. If the loss of the project you are creating on your computer will cause you to cry, then you need to back it up immediately. This rule applies to your Great American Brief that’s due at court shortly. For our purposes, backup means storing it on something other than your computer. It makes no difference if you move it to a floppy disk, tape, USB flash drive, CD, or a hard drive on another computer. External hard drives have dropped in price significantly in the since early last year and most of them include backup software including the ability to “set-it and forget it” to automate your backup. While we obviously would recommend that you use a systematic form of backup, the fact is that doing anything for backup is better than doing nothing.

Nerino has used the following external hard drives with success:
- Maxtor One Touch II (includes Dantz Retrospect backup) [http://www.maxtor.com/](http://www.maxtor.com/)


Manuals do have useful information. There’s a famous acronym: RTFM. It stands for “read the fine manual,” or, ahem, something close to that. More times than you might imagine, the manual for software or hardware, the Help menu or the readme.txt that comes with a downloaded problem may contain the description of your problem and how to fix it. Don’t be afraid to look there. Another great resource is often the company website Knowledge Base. When programs give you an error code, often times there will be an article on topic in the Knowledge Base that can provide you the information that you need to fix it.

For Windows or other Microsoft software problems, the Microsoft Knowledge Base (“KB”) is a good resource at [http://support.microsoft.com/](http://support.microsoft.com/). Most other software and hardware manufacturers also have similar resources available on line.
V. Where’s the Beef - Some of Our Favorite Tips.

Technology... is a queer thing. It brings you great gifts with one hand, and it stabs you in the back with the other. Carrie P. Snow

If the first document didn’t print, the next ten that you send won’t either. Print jobs are put into a “print queue.” If one does not print, the documents later in line will not print until the first job in the queue is cleared. Do not keep sending print jobs. Double-click on the little printer icon on your taskbar. You’ll see the print jobs in line. Delete the first one (or even all of them) and start over. The printer gods are quite fickle and you never want to do anything to offend them.

Stop all that clicking or hitting the Enter key for a minute. Sometimes, people ask us for help with a problem and then start clicking on anything they see before we can say anything or even figure out what is happening. In 99.99999% of cases, this approach will lead to more harm than good. Take a deep breath and be patient.

Right-clicking, once, however, is a good thing. Making one click using the right mouse button almost always brings up a context-sensitive menu that might give you some useful options. If you develop the instinct to right-click, you’ll find many valuable features and options.

Subscribe to at least one computer magazine. It will not make you a nerd or a geek. Spending about $20 a year to subscribe to PC World, CPU (Computer Power User), MaximumPC, Smart Computing, PC Magazine or Computer Shopper is a wise investment. You will find good tips, helpful articles and gradually gain a greater degree of confidence in using computers. Many of these include detailed “How To” articles and information or provide you with links to websites that do. If you leave them around the house, your children will read them and be able to help you even more than they do now.

Computers are like the rest of your office – they like to be cleaned regularly. Dirt, dust and poor ventilation are your computer’s enemies. There is no prize to see who can collect the most dust bunnies. A clean system will run better, quieter and with fewer problems. Have it cleaned at least annually. Ideally, get your computer up off the floor even if only by a few inches.
VI. Our Final Words of Advice!

I think computer viruses should count as life. I think it says something about human nature that the only form of life we have created so far is purely destructive. We've created life in our own image. Stephen Hawking

Computers, like cars, have a useful lifespan. For modern computers a reasonable lifespan is 2 to 3 years (for the really frugal perhaps 4 years). If you’re working on a computer that is older than that, it’s time to say "enough." Bite the bullet, reach into your wallet and replace the computer. Prices have dropped, technology has improved and gotten better. You will appreciate the improvements from moving to a new system. Let’s face it, lawyers can do a lot of things, but even we cannot revive the dead.

If you're the type of person who buys a new car every year or two, you may want to consider the same approach with your personal computer. If you hang on to your trusty (or rusty) car for ten years, you really need to adjust your computer personality. Any computer older than 4 years is at risk of hardware failure. Don't let the untimely death of your dear computer shut down your office. Be proactive and replace the device before it happens.
Additional References.

Home computers are being called upon to perform many new functions, including the consumption of homework formerly eaten by the dog. Doug Larson

In addition to the websites and resources referenced elsewhere in this paper, you can also look to the following articles and web pages to help find answers, suggestions and downloads to make your computing life easier.

Five-Minute Fixes:
http://www.pcworld.com/howto/article/0,aid,118512,00.asp

Super Windows Secrets (Windows 98, ME and XP)
http://www.pcworld.com/howto/article/0,aid,81996,00.asp

PC Problems? Fix’em Yourself
http://www.pcworld.com/howto/article/0,aid,115049,00.asp

2004 Utility Guide
http://www.pcmag.com/article2/0,1759,1585315,00.asp

Hot to Troubleshoot the Worst PC Disasters
http://www.pcworld.com/howto/article/0,aid,110320,00.asp

Other good online resources include:

TechRepublic
http://techrepublic.com.com/

LabMice.net (How To’s, Resources and Downloads)
http://labmice.techtarget.com/windowsxp/default.htm

Mike Lin’s (Utilities)
http://www.mlin.net/

Gizmo Richards’ Tech Support Alert (How To guides and Free Utilities)
http://www.techsupportalert.com/index.html

SnapFiles (Free Utilities)
http://www.snapfiles.com/freeware/freeware.html
Nerino J. Petro, Jr.

Attorney Nerino J. Petro, Jr. is a practicing attorney in Loves Park, Illinois concentrating in Real Estate and Small Business Law serving local and national clients. He is also CEO/ senior legal technologist for CenCom, a Div. of Centro, Inc. providing professional and legal technology services to businesses, lawyers and their staff throughout the country. He is active in the Illinois State and American Bar Associations including the ABA GP, Solo and Small Firm Section Legal Technology Committee and the ABA TECHSHOW Advisory Board. He is an Authorized Independent Consultant for TimeMatters® and Billing Matters® software. His articles can be found in both state and national publications on a range of technology topics. He can be reached at njpetro@lawofficetech.com and www.lawofficetech.com.